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01 Who We Are 
 

Connecticut Center for Advanced 

Technology, Inc. (CCAT), a non-profit 

organization founded in 2004, is an 

innovative applied technology 

organization that leads regional and 

national partnerships that enable global 

industrial companies and the 

manufacturing supply chain across 

industry sectors in driving 

advancements and efficiencies to adopt 

leading-edge technologies, within 

Industry 4.0 disciplines. CCAT operates 

a Talent & Training Accelerator and 

three (3) Advanced Technology 

Centers: (i) Advanced Design, 

Automation & Metrology; (ii) Additive 

Technologies, Optimization & 

Machining; and (iii) Advanced 

Composites Technology Center. The 

Talent & Training Accelerator provides 

hands-on upskilling opportunities for 

the existing industrial base on digital 

transformation concepts and methods.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Each center of excellence utilizes 

advanced manufacturing technologies 

for applied research and development 

with expert staff experienced in metals-

based AM, 3D printing with polymers, 

automated fiber placement for 

composites manufacturing, reverse 

engineering, structured light scanning, 

precision machining, smart 

manufacturing with Artificial 

Intelligence and digital / IIoT 

technologies. In addition, CCAT is a 

member of America Makes, CESMII, 

MxD and ARM Institutes.   

CCAT maintains an extensive 

network of partners throughout the 

regional Defense Industrial Base with a 

focus on small and medium-sized 

manufacturers. CCAT will leverage its 

network and Advanced Technology 

Centers to ensure deliverables focus on 

technologies that provide the greatest 

impact and return on investment.  
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02 Automating CMM Programming by Leveraging 

Model-Based Definition in Siemens Inspection 

 

Siemens NX offers Coordinate 

Measurement Machine (CMM) 

programming capabilities that allow 

users to benefit from time savings of 

up to 90%.  This is due to an 

automated programming process 

that uses the Product Manufacturing 

Information (PMI) of the Model-

Based Definition (MBD) model, along 

with user-defined strategies that 

can be tailored to the 

manufacturer’s best practices. 

 

Siemens NX CMM Inspection 

Programming software has the 

option to use the programming 

language of the user’s specific CMM 

or the Dimensional Measuring 

Interface Standard (DMIS) format.  

In addition to the benefits 

mentioned, users that also work 

within Siemens Teamcenter can 

maintain a central repository of all 

program  

 

 

revisions while offering revision 

control management.   

This Teamcenter workflow ties the 

input MBD model of the CMM 

programming process, to the output 

CMM program, which in turn 

preserves the Digital Thread.  

The following steps are set up by the 

user then employed in Siemens NX 

Inspection to generate a CMM 

program automatically using model-

based definition:   

1. CMM Templates 

2. Defining Inspection Methods 

3. Generate, Verify Program and 

Re-sequence paths 

4. Collision Avoidance 

 

Workflow tutorials are described in 

Appendix A. 

*Please note that the following steps are created 

using Siemens NX Version 2206.
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1. CMM Template 

Creating CMM templates is the 

foundation for automating the CMM 

programming process.  These 

templates are defined by a kinematic 

model of a specific CMM and its 

assigned probe(s) which are typically 

provided by the CMM manufacturer.  

Once setup, users can select the CMM 

template that exactly mimics the 

physical CMM setup allowing for 

accurate simulation and potentially 

eliminating all programming errors.  

 

Key Features of Siemens CMM 

Templates: 

• Time Savings in Program Generation: 

Siemens’ automated programming 

process gives users the freedom to 

quickly make a safe and efficient 

program, with limited programming 

experience.  The user-defined 

templates embody best practices 

created by experienced users, 

optimizing the inspection process.  

• Reduction in Programming Error: 

With the CMM kinematic model 

loaded into a CMM template, 

Siemens NX can generate a CMM 

program that understands where the 

CMM axis limits are, where the 

probe is in relation to objects such 

as the part being inspected or the 

probe rack, and other physical 

considerations, to avoid collisions or 

potential safety risks to the users.  

• Customization: There are a variety of 

ways that a user can customize the 

CMM templates.  For example, the 

user can create various physical 

layouts the CMM may be configured 

to for different processes.   

• Programming Conveniences: 

o Design Change Propagation – 

Within the Method View, features 

are categorized into different 

methods, each of which are 

editable and will propagate these 

changes to each of the 

geometries listed under that 

method. 

o Offline Programming – Programs 

can be seamlessly generated 

without having to connect the 

software to the hardware.  

o Simulation Functionality – 

Simulation tools give a visual 

representation of the program 

and provide options such as 

collision detection to let the user 

know exactly where in the 

program collisions may occur.  

 

2. Link to Product Manufacturing 

Information (PMI) 

By linking to PMI, the user can have NX 

automatically generate a complete 

CMM inspection program by utilizing the 

PMI to drive the program generation 

process.  Siemens NX software reads 

the semantic PMI information, 

associates the characteristics with an 

appropriate inspection method, and 

creates the program steps for the CMM 

to inspect the feature.  

Key Features of using the Link to PMI 

function: 

• Automation: Linking to PMI is central 

to automating the CMM 

programming process.  Siemens 
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uses the assigned PMI, along with 

the CMM’s kinematic model, to 

produce a program.   

• Efficiency: By allowing Siemens NX 

to automatically generate the CMM 

program, an order of magnitude of 

time savings in programming can be 

realized. The Link to PMI function 

allows Siemens to identify features 

that need to be inspected without 

the need for a user to manually 

define each feature nor the need to 

apply an appropriate inspection 

method to each feature.  

• Design Cycle Enhancement: The Link 

to PMI function shortens the overall 

production programming process 

which gives the manufacturer the 

benefit of producing usable 

programs in significantly shorter 

lead times. This ultimately saves 

manufacturers’ cost by requiring 

less time and resources to generate 

a CMM program.  

 

3. Defining Inspection Method 

By defining an inspection method, the 

user can create methods for inspecting 

a feature type. For example, if the part 

that is to be inspected has a series of 

holes, some with tight tolerance 

requirements and some with looser 

tolerance requirements, a method can 

be created for each type. These 

methods can be predefined and reused 

in future programming generations. This 

allows for less-experienced users to 

categorize features into appropriate 

inspection methods that will stage 

downstream manufacturing or 

assembly of the component.   

 

Key Features of defining Inspection 

Methods: 

• Flexibility in programmer experience: 

Less-experienced users can create a 

program using pre-defined methods 

for inspection. Similarly, 

experienced users can generate a 

program in less time because the 

user can quickly categorize the 

features to a suitable pre-defined 

method rather than recreating each 

time.  

• Adhere to company inspection 

standards:  Depending on features, 

some manufacturers elect to inspect 

features in a specific way. Typically, 

this is done to inspect various parts 

in a consistent manner that has 

been internally approved. In other 

cases, a manufacturer’s customer 

may require a specific feature type 

to be inspected in adherence to a 

customer specification. This is a 

means to control this requirement.  

• Utilize best practices: A 

manufacturer may experience a 

unique feature that may or may not 

be shared amongst different product 

lines. This unique feature may 

require some special consideration 

to properly inspect. Through 

experience, a preferred way may be 

desired to be applied to accurately 

inspect a feature.  Utilizing the 

Inspection Methods, this can be 

accomplished.  

 

4. Generate, Verify Program and 
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Resequence Paths 

The Generate, Verify Program and 

Resequence Path functions take the 

changes from modifying or creating 

inspection methods to generate the 

new tool paths for the selected 

operations, verifies there are no DMIS 

syntax, program, or tolerance errors 

and resequences them such that the 

overall program is optimized and 

reduces unnecessary probe movement 

to complete the inspection.  

 

Key Features of Generate, Verify 

Program and Resequence Paths: 

• Automatically generate tool paths 

based on Inspection method 

definition: Once an inspection 

method has been updated or 

created, a tool path needs to be 

generated to the inspection profile 

for the feature to be inspected. 

• Verify Program: By verifying the 

program, Siemens NX software 

performs an analysis on the program 

to determine if the following are 

producing errors: 

o DMIS Syntax: Ensures the PMI 

that is applied to the model 

meets the standard and can be 

properly read for program 

generation. 

o Program: Ensures the program is 

without continuity errors and 

that the program generation is 

complete 

o Tolerance: Verifies that the 

tolerance bands applied to a 

feature can be logically read and 

without human error. 

• Optimization by resequencing: Now 

that new inspection methods are 

created and the program has been 

verified, the Resequence Paths 

function will optimize probe 

movement and reduce probe tip 

changeout (if applicable) to shorten 

the program time. 

 

5. Collision Avoidance 

By using the Collision Avoidance 

function, NX will automatically analyze 

the generated inspection routine to 

identify collisions and will automatically 

insert transition points to prevent any 

collisions. Once the function is run and 

the analysis is complete, NX will 

populate a report stating transition 

points added and will include any 

collisions it could not resolve. Further, 

the user can simulate the process via 

the Simulate Machine option to visually 

see where the collisions are taking 

place.  

 

Key Features of Collision Avoidance: 

• Safety: In any manufacturing 

process, human safety is the top 

priority. By running the Collision 

Avoidance function, Siemens NX will 

analyze the CMM program and will 

prevent the Z-Slide or probe from 

coming in contact with an object 

outside of the required probe 

contact to inspect a feature.  This 

reduces the risk of objects breaking 

off and potentially injuring the 

human inspector.  

• Eliminate equipment or product 

damage:  Similar to human safety, 



Automated CMM 
 

8 
Although this project is sponsored by the U.S. Department of Defense, the content of this publication/video does not necessarily 

reflect the position or policy of the Government; no official endorsement should be inferred  

eliminating damage to the 

equipment or product will prevent 

downtime on the equipment or 

prevent the need to scrap the part 

that is being inspected. 

Leveraging Model-Based Definition 

(MBD) / PMI and Digital Thread 

The benefits of leveraging MBD/PMI 

within the Digital Thread include 

enhanced and shortened design cycle 

times by utilizing incorporated product 

and process information, along with its 

associated inspection practices.  This 

process accelerates decision-making 

for both experienced and less 

experienced users, enabling them to 

apply company standards or customer 

inspection method requirements that 

have been pre-defined, thereby 

reducing inspection errors or non-

compliances.  

 

Siemens NX software can automate the 

CMM programming process. This 

automation reduces programming time, 

frees up inspection equipment and 

ensures a fast response to new designs 

or design changes.  Moreover, this 

process outputs a complete and 

validated CMM program through the 

simulation process, ensuring it is error-

free, safe for the user, and protective of 

equipment and components. 
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03 Automating CNC Programming by Leveraging 

Model Based Definition in Siemens NX CAM 

 

 

 

Siemens Computer-Aided 

Manufacturing (CAM), software is a part 

of Siemens' comprehensive suite of 

solutions designed to streamline and 

optimize manufacturing processes. It 

integrates seamlessly with Siemens 

Product Lifecycle Management (PLM) 

software and other Computer-Aided 

Design (CAD) systems to facilitate the 

efficient design and production of 

complex parts and assemblies. Siemens 

CAM solutions are renowned for their 

capability to support diverse 

manufacturing techniques, including 

milling, turning, and advanced multi-

axis machining. 

 

Siemens CAM solutions incorporate 

several advanced features designed to 

automate and optimize the CNC 

programming process. These include 

the setup template, feature-based 

machining (FBM), teach features, and 

operation sets. Together, these tools 

create a highly efficient, automated, 

and error-minimizing environment that 

leverages MBD and the digital thread.  

 

Workflow tutorials are described in 

Appendix B. 

 

CAM Setup Template 

A "CAM setup template" in the context 

of Siemens CAM solutions refers to a 

predefined configuration that sets up 

the CAM system to handle various 

manufacturing tasks more efficiently. 

These templates are pre-configured 

data sets or files that include all 

necessary parameters, tool data, and 

operational sequences required to 

execute specific machining operations. 

The purpose of a CAM setup template is 

to standardize and expedite the process 

of programming CNC machines, 

reducing the time required to transition 

from design to production, and 

minimizing the potential for errors. 

 

Key Features of Siemens CAM Setup 

Templates: 

• Standardization: Templates provide 

standardized processes, ensuring 

consistent quality and output across 

multiple manufacturing cycles and 

setups. This is particularly beneficial 

for industries where precision and 

repeatability are critical. 

• Efficiency: By using templates, 

manufacturers can significantly cut 

down on the time it takes to set up 

CAM operations. Since the essential 

settings are pre-loaded, CAM 

programmers can avoid starting 

from scratch for each new job, 

making the process quicker and 

more efficient. 

• Reduced Error: With manual 

settings, the likelihood of errors 

increases, which can lead to faulty 
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parts and wastage. Templates 

mitigate this risk by providing tried 

and tested configurations, thereby 

enhancing overall reliability. 

• Customization: Even though 

templates provide a standard setup, 

they are also customizable. This 

allows CAM programmers to tweak 

the templates according to specific 

project needs without deviating from 

the core parameters that define the 

operation's integrity. 

• Learning and Adoption: For new 

users or less experienced operators, 

templates serve as learning tools. 

They help in understanding the 

intricate settings and parameters 

that govern efficient CAM 

operations. 

 

Applications in Industries: 

Siemens CAM setup templates are 

applicable in a variety of sectors such 

as aerospace, automotive, industrial 

machinery, and high-tech electronics, 

where CNC machining is prevalent. 

These templates are instrumental in 

producing complex part geometries 

with high precision on a consistent 

basis. 

 

In practice, once a template is 

developed (often by a more 

experienced CAM programmer), it can 

be reused across similar manufacturing 

tasks or adapted for slightly different 

tasks, significantly contributing to lean 

manufacturing practices. 

 

It is recommended to use CAM setup 

templates to enhance your operational 

efficiency and maintain consistency in 

product quality. These templates can 

be a part of the initial software package 

or can be created and customized 

according to specific user needs. 

Moreover, Siemens often provides 

training and resources to help users 

maximize the benefits of their CAM 

systems, including the effective use of 

templates. 

 

Built-In Feature Based Machining 

Siemens' built-in FBM is an advanced 

capability integrated within Siemens NX 

software. Feature-based machining 

automates many aspects of the 

planning and programming stages in 

CNC machining by utilizing intelligent 

algorithms that automatically recognize 

features of a part model and apply 

appropriate machining strategies based 

on those features. 

 

Core Components of Feature-Based 

Machining 

• Feature Recognition: This is the 

process where the software scans a 

part's 3D model, typically developed 

in a CAD system, and identifies 

standard machinable features such 

as holes, pockets, bosses, and slots. 

The recognition process can be fully 

automatic, where the software 

detects features without user input, 

or interactively, allowing the user to 

guide the recognition process. 

• Knowledge Database: FBM works 

based on a predefined set of rules 

and machining strategies that are 
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linked to specific types of features. 

This knowledge base includes 

recommended tools, sequences, 

and cutting parameters optimal for 

each type of feature identified in the 

part.  

• Automatic Tool Path Generation: 

Once features are identified and 

categorized, Siemens NX 

automatically generates the tool 

paths needed to machine these 

features. This process is guided by 

best practices and predefined 

strategies in the software’s 

database, ensuring efficient and 

error-free programming. 

• Customization and Extensibility: 

Users can modify existing rules or 

add new ones to the FBM’s database 

to tailor the system’s output to 

specific needs or to adapt to new 

types of parts and operations. This 

makes FBM highly adaptable to a 

wide range of industries and 

machining complexities. 

  

Benefits of Siemens Feature-Based 

Machining 

• Reduced Programming Time: Since 

many of the tasks are automated, 

from feature recognition to tool path 

creation, FBM substantially reduces 

the programming time required 

compared to traditional CAM 

methods. 

• Consistency and Standardization: By 

using standardized machining 

strategies stored in its knowledge 

database, FBM ensures consistent 

and repeatable processes, which is 

crucial for maintaining quality across 

multiple parts and production 

cycles. 

• Improved Efficiency: FBM optimizes 

the machining process by selecting 

the most appropriate tools and 

cutting strategies. This optimization 

can lead to significant savings in 

time and material, as well as 

prolonging tool life. 

• Error Reduction: Automating the 

machining process reduces the 

likelihood of human errors in 

programming, which in turn 

decreases costly reworks and scrap 

rates. 

• Scalability and Learning: As more 

features and their respective 

strategies are added to the 

database, the system becomes 

more robust and capable of handling 

an even greater variety of parts and 

complexities more efficiently. 

 

Teach Features 

Teach Features in Siemens NX CAM is a 

functionality that allows users to 

manually identify and define features 

on a part that have not been 

automatically recognized by the 

system’s feature recognition 

capabilities. This can be particularly 

useful when dealing with complex parts 

or when the automatic feature 

recognition does not completely 

understand all design intents. 

The process typically involves the 

following steps: 

• Manual Selection: The user 

manually selects geometric 
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elements on the part model that 

comprise a feature. 

• Feature Definition: The user then 

defines what type of feature 

these elements represent (e.g., 

holes, pockets, slots). 

• Attribute Assignment: Assigns 

attributes such as depth, 

diameter, and other relevant 

parameters to the manually 

defined feature. 

This "teaching" of new features to the 

system helps in refining the CAM 

process, ensuring all necessary 

machining operations are correctly 

planned and executed. 

 

Teach Operation Sets 

Teach Operation Sets refers to the 

capability in Siemens NX to create and 

store sets of machining operations that 

can be easily reapplied to similar 

features in the same project or future 

projects. This facilitates the reuse of 

preferred machining strategies and 

reduces the time required for CAM 

programming on repetitive tasks. 

Steps typically involve: 

• Operation Selection: After 

defining the operations for a 

particular feature or set of 

features, these operations can be 

grouped into a set. 

• Operation Set Saving: This set of 

operations can be saved with a 

specific naming convention that 

reflects its function or the type of 

feature it’s associated with. 

• Reapplication: These saved 

operation sets can then be 

'taught' to new features, either 

within the same part or in 

different parts, where the 

features are similar. This means 

that once a satisfactory set of 

operations is defined, it can be 

quickly applied to similar 

situations without the need to 

rebuild the operations from 

scratch. 

 

Benefits of "Teach" Features and 

Operation Sets 

• Efficiency: Significantly speeds up 

the programming process by 

eliminating repetitive work. 

• Consistency: Ensures consistent 

machining practices are followed 

across similar features in different 

parts. 

• Customization and Flexibility: Allows 

machining strategies to be tailored 

to specific manufacturing or 

company standards and still be 

applied automatically. 

• Learning and Adaptation: The 

software learns from the operations 

and features defined by users, 

making it more robust and versatile 

over time. 

These features in Siemens NX CAM 

assist in bridging the gap between 

automated machine programming and 

the unique needs of custom 

manufacturing environments. They 

improve the workflow by combining 

standardized approaches with flexibility 

and user input, ensuring both 

productivity and high-quality outcomes 

in complex machining tasks. 



Automated CNC 
 

13 
Although this project is sponsored by the U.S. Department of Defense, the content of this publication/video does not necessarily 

reflect the position or policy of the Government; no official endorsement should be inferred  

 

Leveraging MBD and Digital Thread 

Both MBD and the Digital Thread are 

about ensuring that data flows 

seamlessly from design to 

manufacturing and onto other phases in 

the product lifecycle. Siemens CAM 

tools ensure that the transition from 

CAD to CAM is not only smooth but also 

retains all integral data which improves 

decision-making, efficiency, and 

traceability. By integrating these tools, 

Siemens CAM effectively addresses 

several of the traditional challenges 

associated with CNC programming. It 

makes the process faster, less 

susceptible to human error, and more 

closely integrated with the updated 

design data, thereby enhancing the 

overall efficiency and flexibility of 

manufacturing operation. 
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04 Automated Costing by Leveraging Model-Based 

Definition in Siemens

 
 

Siemens Product Cost Management 

(PCM) is software in the Siemens 

Teamcenter suite used for calculating 

costs associated with the 

manufacturing process, enabling 

manufacturers to effectively maximize 

profits. 

 

Benefits of Siemens PCM 

PCM allows for the creation of 

automated quoting workflows, reducing 

the time needed to cost a part. This 

workflow leverages PCM’s ability to 

import data from a Bill of Materials 

(BOM). Once a BOM is created with a 

corresponding import configuration 

within PCM, the entire process of 

calculating a per-piece cost takes just 

minutes to complete. Along with time 

savings, the benefit of this workflow is 

its repeatability. The same part can be 

evaluated multiple times using 

alternative parameters, such as location 

or machine model, to determine the 

most cost-effective method of 

production. The workflows in Appendix 

C demonstrate automated part quoting 

using a BOM in Siemens PCM v2312. 

 

Key Features in Siemens Product Cost 

Management 

• NX CAM Part Metadata: Using NX 

CAM metadata allows for the costing 

process to be tied directly to the 

part model. This means that any 

changes to the manufacturing 

process within the G-code are 

automatically reflected in the 

metadata. Using the metadata as a 

source of truth allows for accurate 

and fast quoting.   

• Part BOM file: The final step before 

importing the part into PCM will be 

to create a BOM file in Excel from 

the operation metadata exported 

from NX CAM. Ideally, the BOM will 

pull data directly from the exported 

file using Power Query, Microsoft’s 

proprietary “data transformation 

and data preparation engine.” Power 

Query can automatically extract, 

load and transform the metadata 

from NX CAM, giving substantial 

time saving over doing the process 

manually. An additional benefit of 

automating the BOM is that when 

the process within NX CAM changes, 

the BOM can be refreshed, with the 

changes automatically reflected. 

The full process of scripting the 

queries using Power Query in Excel 

can be achieved in many ways. For 

reference, linked is Microsoft’s 

documentation for Power Query. 

This tutorial focuses on the initial 

data extracted from NX CAM and the 

final BOM structure to be imported, 

deferring to the reader on 

programming the data 

transformation. Nevertheless, the 

https://learn.microsoft.com/en-us/power-query/
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process of creating the BOM can still 

be done manually, albeit without 

time savings. 
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05 Digital User Stories and Technical Training  
 

CCAT engineers worked with technology partners and Department of Defense 

manufacturers to identify and document user story workflows capturing best practices 

for the development and assessment of digital transformation tools and strategies. 

These products also serve as self-paced software training videos focused on elements 

of MBD-workflows. Each video is publicly available, and the workflows are completed 

with representative parts to ensure these videos can be shared inside and outside of 

Department of Defense suppliers for technical training support.  

 

Manufacturer Testimonials: 

1. Machining Optimization: Third Wave Systems & New England Airfoil Products 

CCAT partnered with a manufacturer, New England Air Foil Products Inc., to bring you 

a realistic and applicable user story in support of the department of defense and its 

digital transformation efforts. Their North American President, Nik Delic, joins us in 

sharing the return on investment, along with their Engineering Manager, Brian Jacobs, 

responsible for the integration and adoption of new technologies.  

 

2. Digital Transformation & Training: BNL Industries 

CCAT’s engineering team has partnered with BNL industries to provide a user story 

focused on sharing the impact of online and in-person technical training offerings, 

along with recommendations from an existing Department of Defense manufacturer for 

others who are looking to jump start their digital transformation initiatives.  

 

 

Technical Training Videos: 

3. Automated Inspection: M3DI & Polyworks 

CCAT partnered with M3DI to demonstrate automated programming for structured 

light scanning workflows with the consumption of model-based definition parts via 

Polyworks Inspector Software. This technology and software provide the ability for 

manufacturers to execute inspection programs, output completed inspection reports 

and upload the report to the inspection directory.  

 

4. Leveraging MBD with CNC Programming: TriMech & SolidCAM 

CCAT partnered with Trimech, to demonstrate SolidCAM, which runs completely inside 

SolidWorks and is a different program compared to SolidWorks CAM. By providing 

videos on both software solutions, our team aims to share the ability to leverage 

model-based definition and digital thread methodologies regardless of the solution 

your company has already invested in to support all manufacturers of all sizes. 

 

https://www.youtube.com/watch?v=l4S3lMJxEQQ&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=5
https://www.youtube.com/watch?v=hOZO-q1nbJ4&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=3
https://www.youtube.com/watch?v=JVkTdq09q7Y&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=8
https://www.youtube.com/watch?v=7_CoQBgT-fk&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=10
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5. Automated CNC Programming: SolidWorks CAM 

To provide training materials to reach the majority of Department of Defense suppliers 

this video provides step by step details on using SolidWorks CAM to create automatic 

CAM programs with the pre-taught machining strategies. If your team uses Siemens 

platforms, check out our other two videos on automated CAM programming using 

Siemens NX. 

 

6. Automated CNC Programming: Siemens NX CAM  

This 2-part video features our Principal engineer Nasir Mannan in the usage of Siemens 

NX to create automated CAM workflows. This is achieved by developing the tool 

selection strategies and machining operations that Siemens can pull to create the CAM 

program. 
 

7. Automated CNC Programming: Siemens NX with Custom Features and Operation 

Sets 

This video is broken down into 3 sections, from creating templates to Siemens NX 

feature based machining capabilities and then onto custom feature development. The 

CCAT team has proven similar workflows on existing supplier parts to demonstrate 

time and cost savings with the implementation and usage of product manufacturing 

information.  

 

8. Automated CMM Programming: Siemens NX 

This video is directly focused on providing a training workflow created and 

demonstration in the Army Digital Proving Ground using the Siemens CMM module for 

automated programming of a CMM using a model-based definition part. You'll hear 

from our principal engineer Nasir Mannan and manufacturing applications engineer 

Chris Miller on this topic.  

 

9. Automated Costing: Siemens Product Cost Management (PCM)  

CCAT engineer, Patrick Jonak, demonstrates a full workflow in Siemens Product Cost 

Management software focused on automated part costing. This user story 

demonstrates the technical capabilities of the Siemens costing platform to support 

manufacturing costing.  
 

10. Automated Welding: Siemens, Capvidia & Visual Components 

Two CCAT's engineers, Chris Miller and Maleeha Wahid are featured to share an 

example workflow for automated welding program development. They begin in 

Siemens NX with a Smit Bracket that highlights weldment call outs. Next, they move 

through a full workflow of robot programming, inspection, and comparison between 

the original CAD model and the final part.  

https://youtu.be/i1d35iWEE8s?si=dDzPPGXBVIMav3h6
https://youtu.be/i1d35iWEE8s?si=dDzPPGXBVIMav3h6
https://www.youtube.com/watch?v=dQax2iPY4VE&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=9
https://www.youtube.com/watch?v=p24DjHC3aKI&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=7
https://www.youtube.com/watch?v=p24DjHC3aKI&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=7
https://www.youtube.com/watch?v=faZwmo061WE&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=1
https://www.youtube.com/watch?v=faZwmo061WE&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=1
https://www.youtube.com/watch?v=HAAZQgzQ37k&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=2
https://www.youtube.com/watch?v=ZTWmM21VKks&list=PLFMDIh3eZ_ISl_U2XZydjf4OoMfV8auW6&index=4
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06 Digital Transformation Resources List 

 

 

 

 

 

 

 

 

 
Hands-on Training 

CCAT’s Talent & Training Accelerator offers monthly training on 

5 Career Pathways: Digital Design & Costing, Digital 

Manufacturing, Digital Inspection/Quality Assurance, Additive 

Manufacturing, CNC Operations and Digital Thread 

  

 
On-Demand Technical Training 

Step-by-step technical workflow training is offered publicly for 

reference via CCAT’s YouTube playlist. Check out the training 

offerings: https://www.youtube.com/@CCATMedia/playlists  

 
Regional Support

NIST supports Manufacturing Extension Partnerships (MEP) in 

all 50 states and Puerto Rico to provide services and resources 

to manufacturers. Check your local MEP out today at: 

nist.gov/mep/centers 

 
Technical Demonstration Projects  

CCAT’s Advanced Technology Center offers demonstrations of 

existing technology with applicable parts and workflows. 

Contact our team today for a consultation! 

https://www.youtube.com/@CCATMedia/playlists
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Connect with us. 

   info@ccat.us 

    CCAT 

    @CCATInc  

    ccat.us 
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Appendix A: Automated CMM Step by Step Guides 
 

CMM Template Tutorial: 

1. Open the model file within Siemens NX 

2. Select File > New… 

3. Select the Inspection  

4. From the list, select the appropriate option that matches the actual inspection 

environment.   

5. Select the current units from the dropdown list 

6. Select File Name and the Part to Reference, if applicable 

7. Click OK 

8. Once NX has loaded, the part will be loaded into the CMM Programming 

environment 

9. From here, the user can use the Move Component function to place the part on 

the CMM where it will be inspected.  If a fixture is required, this can be imported 

as well and the part can be fixed to this imported fixture.  
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Link to PMI Tutorial: 

1. On the top ribbon, ensure the Home tab is selected 

2. Select Link to PMI and a dialog box will open 

3. To have Siemens NX auto generate the program, select Yes in the dropdown box for 

Create Paths 

4. Select the appropriate options Under the Inspection Probe section 

5. Once complete with the dropdown box, click OK 

6. A new dialog box will open stating the PMI that was imported successfully or not 

7. If any PMI was not imported successfully, readdress how the PMI is applied to the 

model and repeat the Link to PMI process 
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Inspection Methods Tutorial: 

1. Enter the Method View to view the existing methods and the features that were 

previously assigned via the Link to PMI procedure 

2. The user is able to do one of two options to modify how a feature is inspected: 

a. If the user decides that all features of a feature type should be inspected one 

specific way, double-click on the desired inspection method and make 

appropriate changes to the dialog box that opens 

b. If the user decides a new inspection method should be created to inspect a 

feature, select the Method function in the top ribbon.  To locate this, be sure 

to be in the Home tab 

i. The user should select the Method Subtype that aligns with the feature 

type,  

ii. Select a location where the method should be stored under,  

iii. And provide a name to this new inspection method 

3. Once the dialog box has opened, the user can modify the pertinent parameters 

that are best fit for the feature 

4. After defining the inspection method parameters, click OK to save the method.   

5. Now the user can select the feature ID and the associated feature path and 

drag-and-drop them into the new inspection method 

 

 
Generate, Verify Program, and Resequence Tutorial: 

1. Once the features have been correctly categorized, ensure that the Home tab is 
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selected  

2. Select the Generate button to create the tool paths 

3. Once the Generate process is completed, select the Verify Program button to 

perform the analysis on the program checking for error 

a. Select a location for the verification file to be saved in for future reference 

4. Select Resequence Paths which will optimize the tool paths to reduce 

inspection time 
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Collision Avoidance Tutorial: 

1. Select the Collision Avoidance button under the Home tab, a dialog box will 

open 

2. Specify safety plane – this is typically the upper most surface so that probe 

head will move and articulate away from the part to maintain a safe process 

3. Specify a clearance distance so that probe angle changes happen at a safe 

distance from the part so that a collision is avoided 

4. The user can further select or deselect options under the Avoidance Methods 

section of the dialog box that meets inspection intentions 

5. Similarly, the Collision Detection Settings can be modified to adjust the 

sensitivity on what is considered a collision 
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Appendix B: Automated CNC Step by Step Guides 
CAM Setup Template Tutorial: 

The following step by step work instructions share the process to set up CAM 

templates in Siemens CAM: 

 

1. Click “File > New”, select “Blank” and press “OK”.  

2. In the ribbon bar, select “Application” and launch “Manufacturing”. 

3. In the “machining environment” pop-up, the automatic selection can be kept. 

Generally, a good starting point for “CAM Session Configuration” is 

“cam_general” and a good starting point for “CAM Setup to Create” is 

“mill_contour”. 

4. Edit the workpiece to select the desired material for the template. Add any 

tools/operations and modify any settings that you want saved when you load the 

template.  

5. Within the operation navigator, right click on the added operations, hover over 

“Object”, and click “Template Settings”. 

6. Checking the “Object can be used as template” box tells NX to load the selected 

item when using this file as a template. Checking the “Create if parent is 

created” will tell NX to create the selected item if the parent item is created (for 

example, creating a certain tool only if the operation that uses that tool is 

created). 

7. Select the appropriate template settings in the tool view, program view, and 

geometry view as well. 

8. Save and close the template file. 

9. Open a part that you’d like to machine using the newly created template. 

10. Launch “Manufacturing”, and at the bottom of the “Machining Environment” 

pop-up, click “Browse for a Setup Part”.  

11. Select the saved template file and click “OK”. 

12. All the template settings are loaded in. The workpiece and blank can be 

selected, and the operations can then be generated. Note, if operations that 

require geometry selection were added to the template, you must modify the 

operation and select the geometry on the workpiece. 

 

Using Siemens CAM Built in Feature-Based Machining Tutorial: 

The following step by step work instructions convey the process of using Siemens 

CAM built in Feature-Based Machining: 

1. Navigate to the Machining Feature Navigator in the left-hand side toolbar.  

2. Right click within the Machining Feature Navigator and select “Find Features”.  



 

27 
Although this project is sponsored by the U.S. Department of Defense, the content of this publication/video does not necessarily 

reflect the position or policy of the Government; no official endorsement should be inferred 
 

3. In the “Find Features” pop-up, set “Type” to “Parametric Recognition”, set the 

desired “Search Method” (“workpiece” is generally good if you want to search 

the entire part), and select the feature types you want found in “Features to 

Recognize” (deselect the ones you aren’t interested in identifying).  

4. Click the “Find Features” icon in the bottom right of the window.  

5. The “Recognized Features” box will be populated with features found that 

match the search criteria. You can remove any features you do not want, then 

select “OK”. 

6. In the Machining Feature Navigator, select all the features, right click, and then 

click “Create Feature Process”. Under “Type” select rule based, make sure all 

the machining knowledge is checked, and then press “OK”.  

7. Within the Operation Navigator, you will now see feature group(s) with 

associated operations. The newly created operations can then be generated. 

 

Teach Features and Operation Sets Tutorial: 

The following step by step work instructions convey the process of using Siemens 

CAM Teach Feature and Operation Sets functionality: 

1. Navigate to the Machining Feature Navigator in the left-hand side toolbar.  

2. Right click within the Machining Feature Navigator and select “Teach Features”. 

3. Under “Select Feature Type”, highlight “CustomerFeature” and then click the 

icon next to “Add New Feature Type”. Type in a name for the feature you intend 

on teaching.  

4. Under “Select Rule”, highlight “CustomerFeature” and then click the icon next 

to “Add New Rule”. The name you created for the new feature type should be 

automatically populated. 

5. Select the faces that make up the feature you are teaching NX to recognize.  

6. Click the icon in the bottom right of the window next to “Teach Recognition 

Rule”.  

7. Right click within the Machining Feature Navigator and select “Find Features”. 

8. In the “Features to Recognize” box, expand the “CustomerFeatures” group and 

notice the new feature you created. Make sure the box next to the new feature is 

checked, and then click the icon in the bottom right next to the “Find Features 

Text”. You should see the newly taught feature populate in the “Recognized 

Features” box. Click “OK”.  

9. In the Machining Feature Navigator, highlight the newly created feature(s), right 

click, and select “Group Features”. In the “Group Features” dialog box, click the 

icon in the bottom right next to the “Create Feature Groups” text, then click 

“OK”.  

10.  Navigate to the Operation Navigator. In the Geometry View, you should see a 

new feature group named after the newly created feature.  
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11. Add in any tools and operations necessary to machine this feature.  

12. Right click the feature group, hover over “Object”, then click “Teach Operation 

Sets”. Highlight the feature group within the “Operation Sets” box, then click the 

icon in the bottom right next to the “Teach Machining Rules” text. This tells NX 

to automatically generate the tools and operations within the feature group 

every time you “Create Feature Process” on this feature type.  

13. To show what you’ve done so far, you can delete the feature group and related 

operations, navigate back over to the Machining Feature Navigator, highlight the 

newly taught feature(s), right click, and select “Create Feature Process”. In the 

pop-up under “Knowledge Libraries”, if you expand “OperationSets” you should 

see the taught feature and the associated feature group containing the 

operations you’ve taught NX to automatically generate. Make sure they are all 

checked off and click “OK”.  

14. If you navigate back to the Operation Navigator, the feature group and the 

taught operation(s) were automatically generated.  

15. Next, we are going to add parameters to the created feature and use these 

parameters to teach NX to use logic when machining the feature based on 

applied PMI. Navigate to the “Applications” ribbon and launch “Modeling”.  

16. Add PMI to the feature you are teaching NX to recognize. Make sure the PMI you 

add is representative of the parameters you want access to in the “Teach 

Operation Sets” dialog. For the added PMI to be converted to a parameter, you 

must add text in the right textbox of the PMI. This text will become the name of 

the parameter. If adding a surface roughness, the text in the “Title” field will 

become the name of the parameter.  

17. Navigate back to the “Applications” ribbon and launch “Manufacturing”.  

18. In the Machining Feature Navigator, right click and select “Teach Features”. 

Select the feature type and the recognition rule of the feature you created, 

which we are now modifying to add parameters. Reselect the face(s) of the 

feature as well. If you are missing a grey box with additional options in the 

“Recognition Rule” field, click the gear icon at the top left of the “Teach 

Features” dialog box, and select “Teach Features (more)”. Then, under 

“Recognition Rule Options”, check the box next to “PMI Annotations”. This adds 

matching conditions from PMI annotations on the feature, assuming the PMI 

was added properly (as outlined previously). Click the “Teach Recognition Rule” 

icon, then click “OK”.  

19. Now, go to the Machining Feature Navigator, and again “Find Features” and 

“Create Feature Process”, making sure the taught feature is checked.  

20. Return to the Operation Navigator, right click on the created feature group 

corresponding to the newly taught feature, hover over “Object” and the click 
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“Teach Operation Sets”. Notice, there are new parameters listed that 

correspond to the PMI added.  

21. Now we are going to change the way NX machines the feature based on the PMI. 

In the Operation Navigator, create a new feature group (or copy the existing one 

and edit it) and add the operations desirable if certain PMI is present on the 

feature. For example, the original feature group may be desirable for loose 

tolerances, whereas the new feature group is desirable for tight tolerances. We 

will define when NX should generate each feature group, and any number of 

different groups can be created and then taught to generate based on different 

PMI conditions.  

22. Make sure to right click on the new/copied feature group, click “Edit”, and select 

the features associated with the group. These should be the same features 

associated with the automatically generated feature group. 

23. For each feature group, right click, hover over “Object” and the click “Teach 

Operation Sets”. Click on the feature group in the “Operation Sets” tab, then use 

the “Parameters” and “Conditions” to create a new condition that tells NX when 

to generate this feature group. For example, you may want NX to generate a 

given feature group when the tolerance range is less than a certain threshold 

value.  

24. Once the condition is complete, click on the check mark icon next to the “Edit 

Condition” box. Then click the icon next to “Teach Machining Rules” in the 

bottom right.  

25. Now if you delete the feature groups and “Create Feature Process” again, NX 

will generate whichever group(s) match the conditions. If you change the PMI 

and return to the Machining Feature Navigator, you’ll see the icon next to the 

feature group has changed (the new icon signifies that associated PMI was 

changed). Right click the feature and click “Approve Changes”. Then you can 

“Generate Feature Process” as normal. 
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Appendix C: Automated Product Costing Step-by-

Step Guide  
 

Exporting NX CAM part metadata tutorial 

1. Find the part to be quoted within your directory. 

2. Open the part with NX CAM. 

3. Right-click anywhere in the “Operation Navigator” sidebar. 

4. Select “Export to spreadsheet” option in the dropdown menu. 

5. A dialog box will open, and you can select the name and location for saving 

your export file.  

6. This will create a “live” Excel file, meaning any changes in the operations on 

the part within NX CAM will be automatically reflected in the file. 

 

Creating a BOM file tutorial 

1. Open the metadata file exported from NX CAM in Excel. 

2. Select the top row of the file, and in the “Editing” section of the “Home” Tab 

click on “Sort & Filter”. 

3. Find the column heading “Tool Number” and click on the dropdown next to 

it. In the menu, filter out the blank values. 

4. Next copy the “Description” and “Time” columns into a new Excel 

spreadsheet. This will be the BOM file.  

5. The final column structure of the BOM: 

a. Line Type: This is an identifier which will determine which column 

values will be populated per row. There should be 4 rows per 

operation, each with one identifier. These are the possible values for 

this column: 

i. Part  

ii. Detail (Detailed manufacturing step) 

iii. B (Labor) 

iv. M (Machine)  

b. Level: The BOM level of each row, starting at 0 for the part level, 

increasing by 1 for each subassembly level. 

c. Item number: The unique identifier for the part within PCM. Must be 

unique, cannot be used by any other part uploaded to PCM. 

d. Description: If the row’s “Line Type” is “Part” then it is the name of 

part. Else, it is the name of the operation.  

e. Region: If the row’s “Line Type” is “Part,” then it is the PCM identifier 

for the region the part is meant to be produced in, e.g. 

“Siemens.TCPCM.Region.Common.USAConnecticut” for Connecticut, 
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USA. Unique identifiers can be found in PCM using Full Text Search 

(FTS). Else, the column value should be blank. 

f. Qty: Quantity of parts to be produced per batch, positive integer 

greater than 0. The value should be the same for all rows. 

g. Qty Units: The unit of measure for quantity. This value should be “pcs” 

for all rows.  

h. Currency: The currency used to quote the part. This value should be 

“USD” for all rows. 

i. Annual Req: If the “Line Type” is “Part,” then it is the total number of 

parts to be produced per year. Else, the column value should be 

blank. 

j. # Mfg Lots: If the “Line Type” is “Part,” then it is the number of lots to 

be produced per year. Else, the column value should be blank. 

k. Life Time: If the “Line Type” is “Part,” then it is the total number of 

years the part is to stay in production. Else, the column value should 

be blank. 

l. Procurement Type: If the “Line Type” is “Part,” then the value should 

be “purchase.” Else, the column value should be blank.  

m. Calculation Quality: If the “Line Type” is “Part,” then the value should 

be “benchmark.” Else, the column value should be blank. 

n. Cycle Time: If the “Line Type” is “Detail,” then the value should be the 

“Time” value from the NX CAM export converted to seconds. The NX 

CAM export is formatted as hh:mm:ss. Else, the column value should 

be blank.  

o. Units: f the “Line Type” is “Detail,” then the value should be “s” for 

seconds. Else, the column value should be blank. 

p. Labor Qualification: If the “Line Type” is “B” then the value should be 

PCM’s unique identifier for a machine operator 

“Siemens.TCPCM.MasterData.CostFactor.Common.MachineOpertor.” 

Else, the column value should be blank. 

q. Labor name: If the “Line Type” is “B” then the value should be 

“Machine operator.” Else, the column value should be blank. 

r. # Labors: If the “Line Type” is “B” then the value should be the 

number of laborers needed to complete all operations, i.e. the 

production line. Else, the column value should be blank. 

s. # Atnd Systems: If the “Line Type” is “B” then the value should be the 

number of machines in the production line. Else, the column value 

should be blank. 

t. Machine: If the “Line Type” is “M” then the value should be the unique 

identifier of the CNC machine used to produce the part. As with 
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“Region”, and “Labor Qualification” unique identifier can be found 

with FTS. Usually, they correspond to the model-name of the 

machine. Else, the column value should be blank.  

6. Please note, as mentioned previously, each operation will need 4 rows with 

each with its associated data, depending on the line type. Take care that the 

operations remain in the order they were exported out of NX CAM. 
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Glossary of Abbreviations 
 

BOM  Bill of Materials 

CAD  Computer Aided Design 

CAM  Computer Aided Manufacturing 

CCAT  Connecticut Center for Advanced Technology 

CMM Coordinate Measurement Machine 

CNC Computer Numerical Control 

FBM Feature Based Machining 

MBD Model-Based Definition 

MEP Manufacturing Extension Partnership 

PCM Product Cost Management 

PLM Product Lifecycle Management 

PMI Product Manufacturing Information 

ROI Return on Investment 

 

 

 


